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Conventions used in this manual

Acronyms used in this manual

Convention Description

 Italic type Indicates placeholders where you specify a value, such as a file 

name, address, or other value. Italics are also used for book titles 

and cross-references to other chapters or sections of this manual.

Bold type Indicates specific choices within instructions or procedures, such 

as keys, buttons, or other dialog box options. For example: Click 

on Software Installation.

Choose File -> Open Indicates a menu selection (such as choosing the Open command 

from the File menu).

monospace bold type Indicates file names, path names, and so on. Code examples are 

also shown in a monospace font.

Press Enter On some keyboards, the Enter key is marked Return. (Similarly, 

some keyboards may use different key labels such as Esc or 

Escape.) Unless it is otherwise noted, you terminate all typed 

commands (such as in a DOS command box) by pressing Enter 

or Return.

Acronym Meaning

arp Address Resolution Protocol

DIB Directory Information Base

DHCP Dynamic Host Configuration Protocol

ESD Electrostatic Discharge

FTP File Transfer Protocol

HTML HyperText Markup Language

HTTP HyperText Transfer Protocol

IP Internet Protocol

IPP Internet Printing Protocol



 

IPX Internetwork Packet Exchange

MAP Management Access Program

MIB Management Information Base

NIC Network Interface Card

NDS NetWare Directory Services

NOS Network Operating System

PCL Printer Control Language

PDS Print Device Subsystem

PPD PostScript Printer Driver

rarp Reverse Address Resolution Protocol

SAP Service Advertising Protocol

SMIT System Management Interface Tool

SNMP Simple Network Management Protocol

SPX Sequenced Packet Exchange

STP Shielded Twisted Pair

TCP/IP Transmission Control Protocol/Internet Protocol

UTP Unshielded Twisted Pair

Acronym Meaning



 

Structure of this manual

• Chapter 1, Introduction, contains information about the Network Interface Board, its 

features, and the hardware and NOS requirements.

• Chapter 2, Installing the Network Interface Board, explains how to install the card.

• Chapter 3, Monitoring the Network Interface Board, explains how to use the Management 

Access Program (MAP) or a Web browser to configure and monitor the Network Interface 

Board.

• Chapters 4 through 7 explain how to configure the Network Interface Board for specific 

environments.

• Chapter 8, Operation and Troubleshooting, contains information on the LED status 

indicators, printing status reports, and resetting the print server to factory defaults. It also 

contains troubleshooting checklists.

• Appendix A, Jumper Settings, describes the jumper settings and locations.

• Appendix B, Network Interface Board Specifications, lists the general specifications for 

the Network Interface Board, including the specifications for the 10/100BaseT cables.
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Chapter 1
Introduction

The Network Interface Board is a Network Interface Controller that you install into 

compatible printers to provide Ethernet® network connectivity.

This chapter describes:

• Network Interface Board features

• Contents of the Network Interface Board package

• Hardware and NOS requirements

1.1 Network Interface Board Features

The Network Interface Board has the following features:

• Automatic selection of 100BaseT Fast Ethernet connection or 10BaseT Ethernet 

connection

• Fully-transparent AppleTalk™ printing support for Macintosh™ systems

• IP Peer-to-Peer (serverless) discovery and printing from Microsoft® Windows™ 

95/98/Me or Windows NT™ 4.0 workstations

• IPX Peer-to-Peer (serverless) discovery and printing from Windows 95/98/Me 

workstations, without a Novell® file server present and without using IP

• Novell NetWare® PSERVER on Bindery based configurations and Novell 

Directory Services (NDS)

•  lpr/lpd over TCP/IP for UNIX™-based systems and Windows systems

• IP and IPX Simple Network Management Protocol (SNMP) support of 

Management Information Base-2 (MIBII) and proprietary NIC-MIB

• SNMP support of standard MIB, MIBII, proprietary NIC-MIB, and proprietary 

printer MIBs on compatible printers

• Integral HTTP server to allow monitoring and management of your Network 

Interface Board from a Web browser such as Internet Explorer or Netscape® 

Navigator, Communicator

• Management Access Program (MAP) to allow Windows-based HTML viewing 

for monitoring and managing your Network Interface Board
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• FTP printing directly from a Web browser or other FTP client

1.2 Network Interface Board Package Contents

The Network Interface Board package contains the following:

• Network Interface Board

• CD-ROM containing:

— This manual

— MAP

— IPX Peer-to-Peer Windows Redirector

— IP Peer-to-Peer Windows Redirector

— NWSetup Utility

Check each directory for a README file containing the latest information about the 

installation and operation. Read these files before installing.
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Note: Each Network Interface Board has a unique six-digit serial number with a three-letter 

prefix — for example, “RDP”. The serial number is listed on the bottom of the Net-

work Interface Board and displayed on the box.

1.3 Hardware and NOS Requirements

The Network Interface Board hardware and software require the following:

Version of protocol or NOS

• Novell NetWare Version 3.x (or higher), 4.x, or 5.x

• Apple Macintosh System 8.x or 9.x.

• UNIX, Windows, or LAN Server systems supporting lpr over TCP/IP

• Sun™ Solaris™ 2.5.1 or 2.6, 7, 8

• Hewlett Packard HP-UX™ 8.x, 9.x, 10.x, 11.0

• RED HAT Linux 6.2

Software

• NetWare printing requires NetWare Capture, NPRINT, and either PCONSOLE 

(later than 1.0) or NWADMIN.

• NWSetup requires Windows 95/98/Me, Windows2000 or Windows NT 4.0 and 

the Novell 32-bit client.

• The IP Peer-to-Peer utility requires Windows 95/98/Me or Windows NT 4.0.

• The IPX Peer-to-Peer utility requires Windows 95/98/Me.

• The MAP utility requires Windows 95/98/Me, Windows 2000 or Windows NT 

4.0. MAP also requires a Web browser such as Internet Explorer or Netscape 

Navigator, Communicator.

• AppleTalk printing requires the appropriate PostScript® Printer Description 

(PPD) for the printer.

• TCP/IP setup and maintenance can be done with Telnet. To monitor and maintain 

with HTTP requires a Web browser.

Hardware

• Support for 10 Mbps Ethernet networks: 10BaseT (twisted pair) cables and 

hardware
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• Support for 100 Mbps Ethernet networks: 100BaseT (twisted pair) cables and 

hardware

• CD-ROM drive on the workstation to accept Windows, Macintosh, or UNIX-

based utilities
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Chapter 2
Installing the Network Interface Board

This chapter describes:

• Installing an Network Interface Board in your printer

• Connecting the Network Interface Board to an Ethernet network

• Powering up the printer

2.1 Installing an Network Interface Board in Your Printer

1. Before installing the board, generate a printer status or test page, if possible.

This gives you detailed information on the identification and configuration of 

your printer, and ensures the printer is set up and operating properly.

2. Make sure the printer is operating properly, there is paper in the paper tray, and the 

toner bottle is setting correctly.

3. Turn off the printer and remove the power cord.

4. Install the Network Interface Board in the option port, according to the printer 

manufacturer’s instructions.

Note: The Network Interface Board is designed to protect sensitive components from dam-

age due to electrostatic discharge during normal operation. When installing the card, 

however, take proper static-control precautions to prevent damage to equipment.



2.2 Connecting the Network Interface Board to an Ethernet Network

2-2 Installing the Network Interface Board 

2.2 Connecting the Network Interface Board to an Ethernet Net-
work

Connect the Network Interface Board to your Ethernet network using the 10BaseT or 

100BaseT Ethernet interface. This network connection uses a 4-wire RJ cable to plug into 

the RJ45 network connector on the Network Interface Board. For a description of the 

signals, see Appendix B, Network Interface Board Specifications.

2.3 Powering up the Printer

1. Plug in the power cord.

2. Turn on the power and wait for the printer to warm up.

The printer may print a status or start-up page if this option is not disabled.

The Network Interface Board then sends a print job to the printer that contains the 
Network Interface Board status information. For more information, see Section 
8.2 Status Report.

3. Check the Network Interface Board status report. Record the serial number (six 

digits with a three-letter prefix) and the network address or save the status report.

You need this information when you configure the printer for your network.

Refer to the chapters relevant to your particular network setup for instructions on 

configuring the network for the Network Interface Board.



Monitoring the Network Interface Board 3-1

Chapter 3
Monitoring the Network Interface Board

This chapter describes:

• Overview of the Management Access Program (MAP)

• MAP requirements

• Where to install MAP

• Installing MAP in Windows 95/98/Me, Windows 2000 or Windows NT

• Using MAP to monitor and maintain the Network Interface Board

• Using a Web browser to monitor and maintain the Network Interface Board

3.1 MAP Overview

The Management Access Program (MAP) provides a Windows-based HTML viewer 

linked to a proprietary bi-directional IPX/IP channel program to allow access to the 

Network Interface Board’s HTML pages for monitoring and maintenance capabilities.

Using MAP lets you:

• Configure your network protocols for the Network Interface Board

• Reset the Network Interface Board remotely or return it to its factory default 

settings

• Troubleshoot problems in the Network Interface Board

• Enable or disable the status sheet printout

• Access a context-sensitive help menu that explains how to use each Network 

Interface Board HTML feature

You can also access the monitoring and maintenance capabilities by using a Web browser 

such as Internet Explorer or Netscape Navigator. The Network Interface Board must have 

an IP address for access with a Web browser.

Note: To change parameter values with MAP or with a Web browser, you must know the 

Network Interface Board management password. The factory default password is 
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sysadm.

3.2 MAP Requirements

To use MAP, your workstation must have the following installed:

• Microsoft TCP/IP protocol

It is not necessary for the network to support TCP/IP. However, the TCP/IP 
protocol must be installed even if the network does not support it.

• A Web browser — such as Internet Explorer or Netscape Navigator

• IPX — if you want to use the IPX search functions

Both the Microsoft standard stacks and Novell 32-bit stacks are supported.

3.3 Installing MAP

You can install MAP on any workstation hard drive or network drive.

To install MAP:

1. Put the supplied CD-ROM into the CD drive of your workstation.

2. Choose Start> Run.

3. Type the following command and click OK:

drive:\MAP\SETUP.EXE

where drive is your CD drive.

4. Read the information in the MAP installation notes.

5. At the prompt “Do you wish to install MAP?,” click Yes.

6. Select a destination directory for the program (default is 

C:\Program Files\MAP) and click Next.

7. Select a program folder (default is MAP) and click Next.

Note: You cannot use MAP with Windows 3.1.
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3.4 Monitoring with MAP

1. To start MAP on your workstation, choose Start -> Map -> Map.

MAP lists IP print servers by their IP address and lists IPX print servers by their 
SAP identification.

2. Select the print server you want to access.

MAP sets up a link to the print server and obtains its HTML page.

3.5 Monitoring with a Web Browser

Once you have assigned an IP address to your Network Interface Board, you can use a 

Web browser, such as Netscape Navigator or Internet Explorer, to view the Network 

Interface Board HTML pages for monitoring and maintenance as follows:

1. In your Web browser, choose File -> Open.

2. Enter the IP address of the Network Interface Board and click OK.

For example:

    http://192.9.200.200

The HTTP Server screen opens.

If you have problems, make sure you are using the correct IP address.
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Chapter 4
NetWare Configuration

This chapter describes configuring the Network Interface Board as follows:

• Using PCONSOLE with NetWare 3.x

• Using PCONSOLE with NetWare 4.x Bindery Services (there is no bindery 

function in Version 5.x )

• Using NWADMIN with NetWare 4.x and 5.x Directory Services

• Using MAP or a Web browser to access parameters for NetWare

• Using standard NW Setup utilities to change the configuration

Note: These instructions assume that your NetWare environment is set up correctly accord-

ing to the Novell documentation.

4.1 Configuring NetWare 3.x

Before configuring NetWare, use MAP or a Web browser to determine if the Network 

Interface Board has the name you want — either the default name or a user-defined name. 

See Chapter 3, Monitoring the Network Interface Board.

Note: Novell recommends upgrading to 4.2 and no longer supports versions lower than 3.2.

The general procedure for configuring the Network Interface Board for NetWare is as 

follows. Refer to the relevant sections in this chapter for detailed information.

• Using PCONSOLE, select the file server you want to use

• Create the print queues

• Specify the Network Interface Board as a print server

• Configure the print server and printer

• Assign the print queues

• Set Notify options
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Note: You must have supervisor privileges to configure the queue. When you are finished, 

turn the printer off and on again. The printer prints a status page that lists the file serv-

ers attached to the unit and the queues it services.

Before you begin:

• Verify that you have supervisor privileges on the file servers on which you are 

entering the Network Interface Board print server and queue.

• Verify that your version of PCONSOLE is later than 1.0.

4.1.1 Using PCONSOLE to Select a File Server

1. Log in as a supervisor or ADMIN.

2. At the command prompt, enter the PCONSOLE command.

3. Choose Change Current File Server from the Available Options menu.

A list of file servers is displayed.

4. Select the file server on which you want to install the print server.

If the name of the file server you want is not displayed, type h to display a list of 
file servers.

5. Log in to the file server.

6. Press the Esc key to return to the Available Options menu.

4.1.2 Creating Print Queues

A print server takes the print jobs from queues and sends them to the printer. The print 

server must be assigned to at least one print queue on the file server.

If the print queue that you want the Network Interface Board to service already exists, and 

you know the name of this queue, refer to Section 4.1.3 Entering the Print Server Name.

If you do not know the name of the queue or it does not exist, create a queue.

To create a queue:

1. In PCONSOLE, choose Print Queue Information from the Available Options 

menu.

A list of existing queues is displayed.

2. Press the Insert key.

3. Enter the name of the queue.
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4. Press the Esc key to return to the Available Options menu.

4.1.3 Entering the Print Server Name

1. In PCONSOLE, choose Print Server Information from the Available Options 

menu.

A list of existing print servers is displayed.

2. Press the Insert key.

The New Print Server Name box is displayed.

3. Enter the name of the print server.

On the printer status sheet, the print server name will appear under NetWare 
information. The default name is the Network Interface Board serial number (six 
digits with a three-letter prefix).

Note: You can change the print server name using the MAP utility or a Web browser. See 

Chapter 3, Monitoring the Network Interface Board.

4.1.4 Configuring the Print Server

1. In PCONSOLE, choose the print server name from the Print Servers list.

The Print Server Information menu is displayed.

2. Choose Print Server Configuration from the menu.

3. Choose Printer Configuration.

The Configured Printers menu appears. Since this is a new Print Server entry, all 
printers are labeled “Not Installed.”



4.1 Configuring NetWare 3.x

4-4 NetWare Configuration 

4. Choose Printer 0.

The Printer 0 Configuration screen appears with a title of “Printer 0.”

5. To change the name that the print server uses in its messages in the Notify list to 

users, select Name and enter a name.

This name helps you identify the printer — for example, LASER_PRINTER.

6. Choose Type.

A list of printer types is displayed.

In the list of printer types, choose Remote Other/Unknown.

This creates default entries in the other fields. These defaults are usually optimal, 
so do not change them without specific knowledge of the effects.

7. Press the Esc key and save your changes. Then continue to press Esc to return to 

the Print Server Configuration menu.  If you have finished the configuration, save 

your changes and exit from PCONSOLE.

4.1.5 Assigning Print Queues to the Printer

When you assign queues to the defined printer, you authorize the print server to service 

these queues.

Note: Do not assign the same queue to two different print servers. If a queue is assigned to 

multiple print servers, print jobs might not go to the intended printer.

To assign print queues to the printer:

1. In PCONSOLE, choose Queues Serviced By Printer from the Print Server 

Configuration menu.

2. Choose the printer name from the list of defined printers.

The Available Queues list for the printer is displayed.

3. Choose the queue you want and then assign a priority level from 1 to 10 (where 1 

is the highest priority. It is also the default).

The queue is displayed on the list for the printer.

You can press Enter again to assign additional queues.

4. When you finish assigning queues, press the Esc key and save your changes.  

Then continue to press Esc to return to the Print Server Configuration menu.  If 

you have finished the configuration, save your changes and exit from 

PCONSOLE.
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4.1.6 Setting Up Notify Options for the Printer

You can specify users or groups of users that are notified if a problem occurs when a print 

job is sent to the printer. The print server supports the enhanced Notify options for 

printers, including informing users when the printer —

• Is off-line, jammed, opened, or out of paper

• Requires a manual paper feed or a form change

• Has had an engine failure

If the print server services queues on multiple file servers, you must set up a Notify list for 

each file server.

To configure the Notify options:

1. In PCONSOLE, choose Notify List for Printer on the Print Server Configuration 

menu.

2. Choose the printer from the Defined Printers list.

3. Press Enter to view a list of Notify Candidates.

4. Select the user or group from the list.

5. Set the First and Next intervals in the Notify Intervals screen by entering a number 

for each interval.

The First interval is the number of seconds the network waits before it notifies 
candidates about a print job problem. The Next interval specifies how often, in 
seconds, candidates are notified.

6. After entering the intervals, press the Esc key and save your changes.  Then 

continue to press Esc to return to the Print Server Configuration menu.  If you 

have finished the configuration, save your changes and exit from PCONSOLE.

4.1.7 Installing the Print Server on Multiple File Servers

To install the print server on more than one file server, perform the procedures described 

in sections 4.1.1 through 4.1.6 for each file server. You must use the same name and 

password (or no password) on all file servers. You can set the password for the Network 

Interface Board using MAP (see Section 4.3 Configuring the Network Interface Board). If 

you use a password, specify it on each file server using the Change Password option on the 

Print Server Information menu of the PCONSOLE utility.

A hop is an intermediate connection in a string of connections linking two network 

devices. For example, on a network, some data packets must go through several routers 

before reaching their final destination. Each time a packet is forwarded to the next router, 
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a hop occurs. The more hops, the longer it takes the data to go from the source to the 

destination.

A tick is 1/100 of a second for the Network Interface Board (Novell has a different value). 

Propagation delay is the time it takes for the data to travel through the network, from the 

source to the destination.

At startup, the Network Interface Board automatically searches for and attaches to the file 

servers that are no more than four hops away and that have no more than eight ticks 

propagation delay. For extremely large or complex networks, this allows a bounded search 

time on startup.

If the print server must attach to file servers beyond this range, or if you want to accelerate 

start up by eliminating the need to search all file servers within the four hops/eight ticks 

radius, enter the name of the file server operating with the print server in the Print Server 

Configuration of a primary file server. The primary file server is a server close to the 

printer and contains a list of file servers that it services. The primary file server can be any 

file server within the four hops/eight ticks propagation time limits but ideally is as close as 

possible to the print server. Once the print server locates the primary file server and the list 

of file servers to be serviced, the automatic search stops and the print server goes directly 

to those file servers listed (and to no others).

4.1.8 Setting Up a Primary File Server

1. Log in to the server you want to designate as the primary server and run 

PCONSOLE on that server.

2. Choose File Server To Be Serviced from the Print Server Configuration menu.

3. Press the Insert key to display the Available File Servers list.

4. Select the name of each file server to be serviced and press Enter to add it to the 

list.

5. When the list is complete, press Esc to return to the menu.

6. Install the Network Interface Board on each primary file server.

4.1.9 Setting Up Preferred File Servers

You can specify a preferred file server on the Network Interface Board (see Chapter 3, 

Monitoring the Network Interface Board). If a preferred file server is listed, the Network 

Interface Board attaches to this identified file server instead of initiating the automatic 

search. If the preferred file server is also a primary file server (for example, has file servers 

listed under File Servers to Be Serviced), the Network Interface Board connects directly to 

these file servers.
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Note: The Preferred File Server applies only to bindery-based queues. There is no effect on 

NDS queues.

4.2 Configuring NetWare Bindery Emulation

NetWare 4.x can operate in two modes:

• NetWare Directory Services (NDS)

• Bindery Services Emulation

For NDS, refer to Section 4.3 Configuring the Network Interface Board.

These services run simultaneously and transparently to each other. You can configure the 

Network Interface Board to operate with Bindery Services Mode only or to operate under 

NDS. When configured under NDS, the Network Interface Board also services older file 

servers operating in Bindery Mode.

Note: If the Network Interface Board is not properly set up for NDS and the Bindery Ser-

vices Mode is not running, the Network Interface Board cannot find its file servers. 

The status page then indicates the NetWare protocol is not active.

4.2.1 Confirming Bindery Context

Before installing the Network Interface Board on a Novell NetWare 4.x server in Bindery 

Emulation Mode, check that the server has a Bindery Context (name for the server under 

Bindery Services Mode). If the server does not have a Bindery Context, you can install the 

Network Interface Board in NDS mode. If the Network Interface Board must be installed 

in Bindery Emulation Mode, the server must have a Bindery Context.

1. At the system console on the 4.x server, enter the load install command.

2. Choose Maintenance/Selective Install from the menu.

3. Choose NCF Files Options from the menu.

4. Choose Edit AUTOEXEC.NCF from the menu.

5. Search the file to see if you have a statement similar to the following:

SET BINDERY CONTEXT=0U=context

where context is the name of your file server context. If this string is not present, 
you can enter it in the autoexec.ncf file.
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6. If you entered a new string in autoexec.ncf, then at the console prompt, enter 

the SET BINDERY CONTEXT statement that you entered in the file.

Note: The command at the console prompt takes effect immediately. The definition in 

autoexec.ncf takes effect when the server is restarted.

4.2.2 Configuring in Bindery Mode with PCONSOLE

Once you confirm the server has Bindery Context, use the following procedures to 

configure the Network Interface Board.

To configure the Network Interface Board with PCONSOLE:

1. Log in as a supervisor or ADMIN.

2. At the command prompt, enter the PCONSOLE command.

3. Press the F4 key to switch to Bindery mode.

Note: If you receive a message asking you to log in to a server with Bindery connections, the 

server you are attached to does not have Bindery Mode enabled. Follow the steps in 

Section 4.2.1 Confirming Bindery Context or log in to a server with Bindery Services 

activated.

4. Choose Quick Setup from the Available Options list.

5. Use Quick Setup to connect your print server, print queue, and printer correctly. 

You can modify these later if necessary.

6. Select Print Server and press F3 or Insert to modify the entry.

7. Enter the name of the print server in the Print Server field.

The print server name appears under Novell Network Information on the Status 
and Configuration report. The default name is the Network Interface Board serial 
number (six digits with a three-letter prefix).

8. Enter a name in the New Printer field.

9. Enter a name in the New Print Queue field.

10. In the Printer Type field, choose Other/Unknown from the list of printer types.

11. When you are finished, press Esc to save the configuration.
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Repeat steps 5 through 11 for each file server that the print server services.

To view, add, delete, or modify print servers or queues after the initial setup, select 
either Print Queues or Print Servers on the Available Options menu.

4.3 Configuring the Network Interface Board

NDS offers a more advanced approach to network management than previous NetWare 

versions. It stores and tracks all network objects. As a rule, all 4.x and 5.x servers must 

have NDS loaded in order to function. In this way, every NetWare 4.x or 5.x server is a 

directory server, because it services named directory objects such as printers, print servers, 

and print queues. With the appropriate privileges, you can create a print server object 

which, once configured in its context (or location) on the network, eliminates the 

cumbersome setup of print servers on every network server. NDS provides true enterprise 

networking based on a shared network database rather than an individually defined 

physical site. The result is greatly improved print server setup and management.

The Directory Information Base (DIB) stores information about servers and services, 

users, printers, gateways, and so on. It is a distributed database, allowing access to data 

anywhere on the network wherever it is stored. NetWare versions earlier than 4.x provide 

the same data found in the DIB, but the NetWare Bindery stores the data. The DIB was 

designed with more flexible access and more specific security; moreover, since it is 

distributed, it was designed to be partitioned. The DIB uses an object-oriented structure 

rather than the flat-file structure of the Bindery, and offers network-oriented access rather 

than the server-oriented access found in the Bindery.

The DIB is backward-compatible with the NetWare Bindery through Bindery Emulation 

Mode. Section 4.2 Configuring NetWare Bindery Emulation describes Print Server 

Operation with a NetWare 4.x system in Bindery Emulation Mode. When Bindery 

Emulation is enabled, Directory Services accept Bindery requests and respond as if a 

Bindery exists on the NetWare server being accessed. Information obtained from the 

Bindery query may not be stored in the server because the DIB is a partitioned and 

distributed database. Even though the NetWare 4.x server is not operating from a Bindery, 

the applications making Bindery requests do not know the difference.

You can use NWADMIN to configure the printer in NDS. Before you can print, NDS must 

be set up as described in the following sections and the Network Interface Board must be 

set up with NDS Context and Tree. See Section 4.4 Configuring the Network Interface 

Board.

The following sections describe using NWADMIN to create printer, print server, and print 

queue objects. You can assign or associate these objects with each other. You can keep 
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Bindery resources on any server under NetWare 4.x if you include a SET statement in your 

autoexec.ncf file.

Alternatively, you can use PCONSOLE to set up static information about print servers, 

such as the queues to service and whom to notify in the event of a problem. Refer to the 

NetWare documentation for more information about the use of PCONSOLE for NDS.

4.3.1 Creating the Printer Object

1. Start NWADMIN. (For example, double-click the NWADMIN icon in the 

NetWare Tools group.)

The NetWare Administrator window opens.

2. Choose Object -> Browse.

Your directory tree is displayed.

3. Select the Organizational Unit or Organization where you want to create the 

printer in the Directory Tree, and choose Object -> Create.

The New Object windows appears.

4. In the Class of New Object list, choose Printer and click OK.

5. When the Create Printer window appears, enter a value in the Printer Name field 

and click Create.

4.3.2 Creating the Print Server Object

To create a print server object:

1. In NWADMIN, choose Object -> Browse.

2. Select the Organizational Unit where you want to create the print server in the 

directory tree and choose Object -> Create.

3. In the New Object window, scroll down the Class of New Object list, choose 

Print Server and click OK.

4. When the Create Printer window appears, enter a value in the Print Server Name 

field and click Create.

4.3.3 Creating the Print Queue Object

1. Start NWADMIN.

2. Choose Object -> Browse.

3. Select the Organizational Unit where you want to create the print queue in the 

directory tree and choose Object -> Create.
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4. In the New Object window, scroll down the Class of New Object list, choose 

Print Queue and click OK.

5. In the Create Print Queue window, click Directory Service Queue, enter values 

for Print Queue Name and Print Queue Volume and click Create.

If you do not know the Print Queue Volume name (the hard drive you are 
accessing), click the icon to the right of the volume field. The Select Object 
window opens with the volume listed in Objects. If the volume is not listed, scroll 
through the Directory Context items to find the volume where you want the queue 
to reside.

6. Click the object (hard drive) of your choice.

The object appears in the Selected Object field. 

7. Click OK and then click Create.

4.3.4 Assigning the Printer Object

1. In NWADMIN, choose Object -> Browse.

2. In the NWADMIN directory tree, double-click the printer object created in 

Section 4.3.3 Creating the Print Queue Object.

The Printer window opens.

3. Click Assignments and then click Add.

4. When the Select Object window opens, find the print queue object just created 

and select it.

5. Click OK.

The print queue just created appears in the Print Queues list in the Printer window.

6. Click OK.

4.3.5 Assigning Print Server Object

1. In NWADMIN, choose Object -> Browse.

2. In the NWADMIN directory tree, double-click the print server object you just 

created.

The Print Server window opens.

3. Click Assignments and then Add.

4. When the Select Object window opens, select the printer object just created in the 

Objects list and click OK.

The printer (with its context) appears in the Printers list.
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5. Click OK.

4.3.6 Checking Assignments

1. In NWADMIN, choose Object -> Browse.

2. In the NWADMIN directory tree, double-click the print queue object.

The Print Queue window opens.

3. Click Assignments.

If you configured the print queue and printer correctly, they will appear in the 
proper boxes in the Print Queue window.

4. Click Cancel.

4.3.7 Setting Up and Resetting the Printer

After completing the NWADMIN configuration, you must set up and reset (power cycle) 

the printer before you can begin printing.

4.4 Configuring the Network Interface Board

Use the MAP utility or a Web browser to:

• Define the context and tree of the Print Server

• Change the Print Server name

• Set a password

• Set values for Bindery Mode

For more information, see Chapter 3, Monitoring the Network Interface Board.

To configure the Network Interface Board:

1. Access the setup pages for the Network Interface Board using MAP or a Web 

browser.

2. Once you have accessed the Network Administration pages or the Main Menu, 

choose Setup NetWare under Protocols.

3. Confirm that there is a check mark in the Enable NetWare option. If necessary, 

put a checkmark in that option.

4. Optionally, enter a name in the Print Server Name field.

To use the default name, leave the field blank.
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The default name is the Network Interface Board serial number (six digits with a 
three-letter prefix). This is also the default name of the printer in peer-to-peer 
mode.

Note: If you make any changes, you will be prompted for a password. The default password 

is sysadm.

5. Optionally, to secure the Network Interface Board with a password, enter a 

password in the Print Server Password field and again in the Password Retype 

field.

If you are using a password, use the same password for all bindery-based and 
NDS-based Print Server entries.

If you enter a password, you must also enter the same password in the password 
field on your file server setup using PCCONSOLE or NWADMIN.

6. For Bindery emulation, enter the name of a preferred bindery-based file server in 

the Preferred File Server field.

The Preferred File Server entry applies only for Bindery- or Bindery Emulation-
based operations. See Section 4.1.9 Setting Up Preferred File Servers for the 
significance of a Preferred File Server. The Print Server must be configured on the 
preferred file server. Incorrect setup of a Preferred File Server can interfere with 
NetWare printing.

7. If the Print Server operates under Novell Directory Services, enter a Context and 

Preferred NDS Tree in the appropriate fields.

Be sure to give the whole context, whether typed or typeless, and do not begin 
your context path with a leading period.

An example of a typed context name is ou=standard.ou=organization_1.

(If you do not know your tree, open a DOS command box and enter the whoami 
command.)

An example of a typeless context name is organization_1.

You must use a typeless context if the Network Interface Board is on the same 
network segment as the file server.

8. Enter the time intervals, in seconds, in which the Print Server will scan the queues 

that it services in the Print Queue Scan Rate field.

The default scan rate is once per second.

9. If your network uses multiple frame types for Novell, you can bias the frame 

search to the desired type by setting the radio button next to the designation under 

Ethernet Frame Type.
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The Network Interface Board normally monitors the network to determine which 
frame type is used for Novell. When it recognizes a type, it assumes the same 
frame type. Once it selects a frame type, the Network Interface Board only 
operates over that Novell frame type. Monitoring normally starts looking for 
IEEE 802.3, then Ethernet II, then 802.3 SNAP, and so on.

10. If you are operating in NDS mode only, you can disable Bindery Mode on the 

Print Server by putting a checkmark in the Disable Bindery checkbox.

If you disable Bindery Mode, the Network Interface Board does not support Print 
Servers on a Bindery file server.

11. Once you have selected all desired settings and entered the desired NetWare 

information, click Accept Settings to save this information in the Network 

Interface Board NVRAM.

If you have not entered the Network Interface Board Management password 
previously during this session, you must enter it in the appropriate space before 
clicking Accept Settings.

The values you entered do not take effect until the Network Interface Board is reset or 

power cycled. You can reset from MAP or the Web browser by returning to the home page 

or Network Administration page, and clicking Reset under System, and then clicking 

Reset Unit. Alternatively, you can power cycle the printer. The new NetWare values are 

now in effect.

4.5 Using the Novell PCONSOLE Utility

You can use the PCONSOLE utility to:

• Attach and select a file server

• Select or delete queues for the print server

• Set up the Notify function

See the NetWare Print Server Manual for detailed information on this utility.

Note: You must have Supervisor privileges to perform many PCONSOLE operations.

4.5.1 Changing the File Server

1. Log in to the file server and run PCONSOLE on that server.

2. Choose Change Current File Server from the Available Options menu.

3. Press the Insert key to display the available file servers.
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4. Select the file server you want.

5. Enter your username.

If the username requires a password, the Password screen appears. Enter the 
password.

The name of the file server appears in the status header at the top of the 
PCONSOLE window.

4.5.2 Changing Print Queues

When you print a file, your system sends the file to a print queue. The print server 

assigned to that queue extracts the print job and sends it to the assigned printer. If a print 

server services queues on multiple file servers, you must assign queues to the printer on 

each file server.

To change the print queues:

1. Log in to the file server and run PCONSOLE on that server.

2. Choose Print Servers from the Available Options menu.

3. Select the print server you want.

4. Choose Printers from the Print Server Information window.

5. Select the printer you want.

6. In that printer’s Configuration Menu, choose Print Queues Assigned.

7. Select a queue from the list.

8. Select the priority for the print queue.

The highest priority queue is 1 (which is the default); the lowest is 10.

9. Press Esc and save all changes.

4.5.3 Setting Up a Notify List

You can specify users or groups of users that are notified if a problem occurs when a print 

job is sent to the printer. The print server supports the enhanced Notify options for 

printers, including informing users when the printer —

• Is off-line, jammed, opened, or out of paper

• Requires a manual paper feed or a form change

• Has had an engine failure

If the print server services queues on multiple file servers, you must set up a Notify list for 

each file server.
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To set up a Notify list:

1. Log in to the file server and run PCONSOLE on that server.

2. Choose Print Servers from the Available Options menu.

3. Select the print server you want.

4. Choose Printers from the Print Server Information window.

5. Select the printer you want.

6. In that printer’s Configuration Menu, choose Notification and press Enter.

7. Press the Insert key to get a list of available options.

The Notify Candidates screen appears.

8. Select the notification candidate you want.

The Notify Interval screen appears.

9. Specify the notify intervals you want.

The First interval is the time the network waits before it notifies users about a 
print job problem. The Next interval specifies how often users are notified.

10. Press Esc and save all changes.

4.6 Configuring NetWare and Print Servers Using NWSetup

The NWSetup program lets you set up NetWare and your network interface card (NIC) 

using one program. NWSetup combines the following configuration steps:

• Setting up the Novell file servers and print servers for NetWare printing (without 

using NWSetup utilities)

• Setting up your print server printers for network printing

4.6.1 Installing and Running NWSetup

1. Put the CD-ROM into your CD drive on your workstation.

2. Choose Start -> Run.

3. Type the following command and click OK:

drive:\NWSETUP\SETUP.EXE

where drive specifies your CD drive.

4. Follow the instructions in the Setup program.

After you install NWSetup, a program icon appears in your Start menu. To start the 

program, choose Start -> NWSetup -> NWSetup.
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Note: If you are configuring for NDS, make sure you are logged in to the correct tree and 

context before running NWSetup.

4.6.2 Selecting a Print Server

NWSetup displays a list of all NICs available on your network. Each NIC is listed with its 

serial number.

Note: NWSetup allows configuration of NICs that are connected to the same context of your 

NetWare server as the workstation running NWSetup.

To choose the NIC you want to configure, do either of the following:

• Highlight the NIC you want and click Select.

• Double-click the NIC you want.

The Print Server Settings screen appears. This screen lets you set up your version of 

NetWare for the NIC.

4.6.3 Configuring the Network Interface Board for NetWare

There are two Settings screens that you need to complete to configure the Network 

Interface Board for NetWare, including Directory and Bindery Services.

The following table describes the fields on the Settings screens.

Field Description

Print Server 

Name

Indicates the NetWare print server name that the Network 

Interface Board uses to log in to NetWare. You can enter any 

name that does not already exist in the network directory or 

server bindery.

The maximum length is 48 characters.
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Print Queue Scan 

Rate

Specifies the rate at which a Network Interface Board polls 

print queues for a new print job. For example, if you put 1 in 

the field, the Network Interface Board polls for new print jobs 

each second.

The minimum value is 1 and the maximum is 250.

Print Server 

Password and 

Print Server 

Password Retype

Indicates the password for a Network Interface Board used to 

log in to NetWare. When you change this field, NWSetup sets 

the password in both NetWare and the Network Interface 

Board.

The maximum length is 32 characters.

Note: The values in the Password and Password Retype 

fields must be identical before you can choose Finish on 

this screen.

Ethernet Frame 

Type 

Indicates the Ethernet frame type that should be used by the 

NetWare protocol stack by default. Only one frame type can be 

selected.

Enable NDS 

Mode

Indicates whether the Network Interface Board supports 

Directory Services. When the box is checked, the Network 

Interface Board supports Directory Services.

If this box is not checked, all other fields on this screen are not 

enabled.

Preferred NDS 

Context

Enter a text string to set the NDS directory context that the 

Network Interface Board uses to log in to the network. The 

maximum length is 128 characters.

Preferred NDS 

Tree

Enter a text string to set the NDS tree that the Network 

Interface Board uses to log n. The maximum length is 48 

characters.

Enable Bindery 

Mode

Determines whether the Network Interface Board should 

attempt to service the NetWare network in Bindery Mode.

If this option is not enabled, the Primary File Server option is 

not enabled.
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4.6.4 Entering Print Server Settings

NWSetup also lets you set up each print server and queue. This information is usually 

entered using NWADMIN or PCONSOLE. NWSetup eliminates the need for configuring 

the file server with any NetWare utility.

The following table contains a description of the NWSetup dialog box options.

Primary File 

Server

Specifies the NetWare file server that the Network Interface 

Board uses as the primary file server. If no primary file server 

has been selected yet, or if an unavailable server is selected, 

the first file server in the list is selected.

Dialog Box Option Description

Enable Printer Indicates whether support for the Network Interface Board 

and printer is enabled.

• If this box is checked, then the printer is enabled.

• If the box is not checked, then the printer is not enabled. 

and the remaining fields on the screen are disabled.

Printer Displays the name of the printer. This is a read-only field.

Queues Serviced by 

printer-name

Lists all the queues that are to be serviced by the printer.

• Queues associated with bindery connections are listed in 

the format bindery server name: queue name.

• Queues associated with NDS connections are listed by 

their distinguished names.

For example: If a printer services a queue named 

YOURPTR_Q on a bindery server named OLD_SERVER, the 

queue is named OLD_SERVER:YOURPTR_Q. If an NDS 

server has a distinguishing name such as 

ENGINEERING.CORP and a queue named 

ENGINGEERING_Q servicing the printer, the queue is listed 

as ENGINEERING_Q.ENGINEERING.CORP.
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Users/Groups 

Notified by printer-

name

Lists all users and user groups who are notified when a 

printer error is detected.

• Users and groups associated with bindery connections 

are listed in the format bindery server name: user name.

• Users and groups associated with NDS connections are 

listed by their distinguished names.

For example: If a user named Susan on the bindery server 

OLD_SERVER is listed on the printer’s notify list, the user is 

listed as OLD_SERVER:SUSAN. If a user named Albert 

with an NDS context of ENGINEERING.CORP is on the 

printer’s notify list, that user is listed as 

ALBERT.ENGINEERING.CORP. When you double-click an 

entry in this field, the Notify Settings screen appears. See 

Section 4.6.5 Configuring the Notify Settings.

Note: The Network Interface Board supports the Notify 

function only in Bindery Mode.

Add Queue/

Delete Queue

Select Add Queue and/or Delete Queue to make changes. 

See Sections 4.6.4.1 Adding a Queue and 4.6.4.2 Deleting a 

Queue for detailed information.

Add User/

Delete User

Select Add User or Delete User to add or remove users or 

groups for notification. See Section 4.6.4.3 Adding Users/

Groups for Notification.

Dialog Box Option Description
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4.6.4.1 Adding a Queue

To add a queue to the printer, click Add Queue.

A dialog box opens containing the following buttons and fields:

Create Queue • Queue Name — Enter the name of the new queue. This 

field must be completed in order to create a new queue. 

The maximum length is 48 characters.

• File Server Volume — Indicates the volume on which 

the queue should be created. This field is enabled only if 

the current connection is an NDS connection. When 

enabled, it contains a list of all available volumes. For 

Bindery Services, the default volume name is SYS.

• NDS Context — Specifies the NDS context in which 

the queue is created. This field is enabled only when an 

NDS connection is being used. When this field first 

appears, it lists the NDS context specified in the Add 

Queue dialog box. If you change the context, NWSetup 

verifies that the new context exists on the directory tree. 

Click OK to start the verification process.

Dialog Box Option Description
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Dialog Box Option Description

Create Queue • Queue Name — Enter the name of the new queue. This 

field must be completed to create a new queue. The 

maximum field length is 48 characters.

• File Server Volume — Indicates the volume on which 

the queue should be created. This field is enabled only if 

the current connection is an NDS connection. When 

enabled, it contains a list of all available volumes. For 

Bindery Services, the default volume name is SYS.

• NDS Context — Specifies the NDS context in which 

the queue is created. This field is enabled only when an 

NDS connection is being used. If you change the 

context, NWSetup verifies that the new context exists 

on the directory tree. Click OK to start the verification 

process.

Connection/Server Selects a server connection. This list includes the NDS 

connection and all of the bindery file server connections 

that the user has. The NDS connection is always listed first, 

by default. When a new connection is selected, the Queue 

field is automatically updated.

NDS Context Specifies an NDS context for the queue. NWSetup lists all 

the queues within this context or the subcontexts in the 

Queue field. This field is only enabled when NDS support 

is enabled. By default, the NDS Context should be set to the 

preferred NDS context specified in the Print Server Settings 

screen.
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4.6.4.2 Deleting a Queue

1. In NWSetup, highlight the queue you want to delete.

2. Click Delete Queue.

A confirmation screen asks if you really want to delete the highlighted queue.

3. Select Yes to delete or No to cancel.

Note: Deleting a queue does not physically remove it from the file server. To remove the 

queue from a file server, you must use the NetWare utility to delete the queue from the 

file server queue list.

4.6.4.3 Adding Users/Groups for Notification

To add users and groups for notification, click Add Users/Groups. A dialog box opens, 

containing the following buttons and fields:

Queue Lists all queues available on the currently selected 

connection.

• If an NDS connection is specified, then a list of all 

queue names in the selected context and all subcontexts 

displays.

• If you change the context in the NDS Context field or 

change the connection in the Connection/Server field, 

the queue list refreshes to reflect the new connection or 

context.

• If you double-click a queue in the list, the queue is 

automatically added to the printer’s service and you exit 

this screen.

Dialog Box Option Description

Connection Selects a connection from this field. This list includes the 

NDS connection and all of the bindery file server 

connections that a user can access. The NDS connection is 

always listed first, by default.

Dialog Box Option Description
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4.6.5 Configuring the Notify Settings

To configure the Notify function for the users or group, double-click an entry in the Users/

Groups Notified by Printer field on the Print Server screen. The Notify Settings screen 

appears with the following options.

NDS Context Specifies the NDS context to use when generating a list of 

users and/or groups. This field is enabled only for NDS 

connections. When first displayed, this field lists the 

preferred NDS context specified in the Print Server Settings 

screen. If you change this value, NWSetup verifies that it is 

correct when you attempt to move to another field or when 

you click OK.

Users/Groups Lists all the users and groups available on the selected 

connection. Any entry on this list can be added to a 

printer’s service list. The list includes print job owner (the 

user whose job is currently being printed).

• If an NDS connection is selected, NWSetup generates a 

list of all users and groups in the currently selected 

context and all subcontexts.

• When you double-click an entry in the list, the entry is 

added to the printer’s service list.

• The user/group list is updated whenever the Connection 

or NDS Context field is changed.

Delay in seconds for 

first

Indicates how long the Network Interface Board should 

wait before sending a notification message that an error 

condition has been detected.

Delay in seconds for 

repeat

Indicates how long the Network Interface Board should 

wait before sending a repeat notification of an error 

condition.

Note: The Network Interface Board supports Notify in 

Bindery Mode only.

Field Description
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User/Group 

name

Indicates the name of the user or group that is being edited. 

This field cannot be changed.

Delay in seconds 

for first

Indicates how long the Network Interface Board should wait 

before sending a notification message to the user that an error 

condition has occurred.

Delay in seconds 

for repeat

Indicates how long the Network Interface Board should wait 

before sending a repeat notification message to a user or group 

when an error condition has occurred.

Note: The Network Interface Board supports Notify in 

Bindery Mode only.
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Chapter 5
Windows Peer-to-Peer Printing

This chapter describes:

• Windows IPX Peer-to-Peer Printing, including preparing for the installation, 

installing, operating, setting up printing, and adding printers.

• Windows IP Peer-to-Peer Printing, including preparing for the installation, 

installing, setting up printing, and adding printers.

5.1 Windows IPX Peer-to-Peer Printing

Windows IPX Peer-to-Peer printing allows workstations to print to Network Interface 

Board printers without an intervening server and without using IP. The main features of 

Windows IPX Peer-to-Peer printing are:

• Runs on Windows 95/98/Me workstations “out of the box”

• Runs on networks with or without a NetWare file server

• Implements IPX peer-to-peer bi-directional printing between Windows 

workstations and Network Interface Board printers

5.1.1 Introduction and Preparation

The Peer-to-Peer implementation uses the IPX/SPX stacks provided with Windows

95/98/Me. The redirector software provided establishes a connection with the printers 

supporting IPX Peer-to-Peer, without using an intermediate file server, whether your 

network uses NetWare or not.

When configuring the network capabilities for Windows, you must include the 

IPX/SPX Compatible Protocol. If you are not using NetWare, you need not activate any 

NetWare Client application.

You can include IPX/SPX after the initial Windows installation by choosing Start -> 

Settings -> Control Panel -> Network. You will also need the Windows disks or 

CD-ROM.
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Note: Peer-to-Peer printing uses the IPX/SPX protocol. Therefore, Novell operation must 

remain enabled on the Network Interface Board even if you are not using Novell print-

ing facilities. The name of the Peer-to-Peer printer in the Windows Port List is the 

same as the Novell Print Server name. You can change the Novell Print Server name 

using MAP or a Web browser. See Chapter 3, Monitoring the Network Interface 

Board.

On power-up, the Network Interface Board checks the network for any Novell activity. If 

there is activity, the Network Interface Board uses the frame type and the local network 

number that it senses. In addition, if the Network Interface Board can log in to a file 

server, it assumes Novell is normally used and stores this frame type and new number in 

NVRAM. Thus, when the Network Interface Board comes up again, it does not have to 

spend time sensing (which can cause a delay).

However, if the Network Interface Board cannot attach to a file server, it will use the 

sensed values but will not store them.

If the Network Interface Board does not see any Novell activity, it uses 802.2 on 802.3 as 

a frame type and assigns itself a network number of 0 (zero). The status and configuration 

sheet contains information on the frame type and network number used.

If you move Network Interface Board from a site that has active NetWare to a site that 

does not, you should reset the Network Interface Board to factory default values to clear 

the frame type and network number information.

5.1.2 Installing the IPX Peer-to-Peer Redirector

1. Put the CD-ROM labeled “Print Server Software and Documentation” into your 

CD drive.

2. Choose Start -> Run.

3. Type the following command and click OK:

drive:\IPX-P2P\SETUP.EXE

where drive specifies the CD drive on your system.

4. Follow the instructions in the Setup program.

Note: If there is a previous installation of the IPX Peer-to-Peer Redirector, the Setup pro-

gram prompts you to have Setup delete the old driver and continue the installation 

procedure. Click Yes or No.
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Once the redirector is installed, each printer on the network that supports this peer-to-peer 

capability appears as a port under Printer Properties.

5.1.3 Setting Up IPX Peer-to-Peer Printing

IPX Peer-to-Peer printing allows you to print to a network printer for networks without a 

file server or for networks where you do not want to use the server for printing. Use peer-

to-peer printing on Windows 95/98/Me systems.

To set up IPX Peer-to-Peer printing, choose Start -> IPX-P2P -> IPX-P2P. The IPX 

peer-to-peer printing setup screen appears. The following table describes the fields and 

buttons in the screen.

Field or Button Description

Available 

Printers

The list of printers detected on the network. To clear this list, 

click Clear. To update the list, click Find Printers.

• Unit Name — The Print Server Name defined in the printer. 

The default name is the Network Interface Board serial 

number (six digits with a three-letter prefix).

• Description — Typically, the manufacturer’s name and the 

printer's model number.

• Flags — Selected (S) or Permanent (P)

Any printers flagged with S appear in the Windows Port List. 

When you are adding or changing a printer, only selected 

printers are listed. Only 30 printers can be selected at one time.

Any printer flagged with P remains in the Available Printers list 

even if the printer is physically removed from the network or if 

you click Clear.

OK Accepts changes made to setup and exits the program.

Cancel Discards any changes made to setup and exits the program.

Clear Clears the Available Printers list. This does not clear any printer 

marked with the Permanent flag (P).
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5.1.4 Adding Printers for IPX Peer-To-Peer Printing

You can add printers manually if the program cannot find printers automatically because 

of router setup or hop count setting. In general, this should not be necessary.

Using IPX-P2P to Add Printers to the port list:

1. Choose Start -> IPX-P2P -> IPX-P2P.

The IPX Peer-to-Peer Setup screen appears. A list of available IPX-enabled 
printers appears after a brief pause while the program searches the network.

2. Highlight one or more printers you want to display in the Windows Printer Port 

listing and click Select.

This ensures that these printers are included in the Windows Printer Port listing. 
You can have a maximum of 30 printers selected at a time.

3. Click OK when you have finished selecting all the printers you want to display in 

the Windows Printer Port list.

Using the Add Printers Wizard:

1. Choose Start -> Settings -> Printers.

Delete Deletes the highlighted printers from the Available Printers list. 

Printers deleted this way no longer appear in the Windows Port 

List when you are adding a printer. However, the printer is not 

actually deleted from the network — it is only removed from the 

list. You can put the printer back on the list by clicking Find 

Printers, so long as the printer is still connected to the network.

Permanent Flags the highlighted printers with a P. These printers remain in 

the Available Printers list even if the printers are physically 

removed from the network or you click Clear.

Find Printers Searches the network for printers and lists them by their Print 

Server Name (defined in the printer). The default name is the 

Network Interface Board serial number (six digits with a three-

letter prefix).

Select Flags the highlighted printers with an S. Only 30 printers can be 

selected at one time. When the Windows Port List is displayed 

during the process of adding or changing a printer, only selected 

printers are listed.

Field or Button Description



5.2 Windows IP Peer-to-Peer Printing

Windows Peer-to-Peer Printing 5-5

2. Double-click Add Printer.

The Add Printer wizard appears. Click Next to proceed.

3. Choose the Local Printer option and click Next.

4. Select the make and model of the printer you want to use and click Next.

A list of printer ports appears. Any IPX peer-to-peer printers that have been 
selected from IPX-P2P Setup appear in this list.

5. Select the IPX printer you want to use.

6. Complete the remainder of the printer setup procedure as you would normally.

To change the printer port:

1. Right-click the printer icon.

2. Choose Properties and then choose the Details tab (it can take up to 15 seconds 

to access).

3. Select the printer address you want to use from the Print to the Following Port 

list. (In Windows NT and Windows 2000, you must first deselect the previous 

printer port.)

4. Click OK.

5.2 Windows IP Peer-to-Peer Printing

Windows IP Peer-to-Peer printing allows Windows 95/98/Me workstations or Windows 

NT 4.0 workstations and servers to print to Network Interface Board printers without an 

intervening server and without using IPX. The main features of Windows IP Peer-to-Peer 

printing are:

• Runs on Windows 95/98/Me workstations and on Windows NT 4.0 workstations 

or servers “out of the box”

• Implements IP peer-to-peer bi-directional printing between Windows 

workstations and Network Interface Board printers
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5.2.1 Introduction and Preparation

The Peer-to-Peer implementation uses the TCP/IP stacks provided with Windows 

95/98/Me or Windows NT. The redirector software provided establishes a connection with 

the printers supporting Peer-to-Peer, using a direct IP connection over the network.

When configuring the network capabilities for the Windows computer, you must include 

the TCP/IP Protocol. You do not need to activate any TCP/IP Client application.

You can include TCP/IP after the initial Windows installation by choosing Start -> 

Settings -> Control Panel -> Network. You will also need the Windows CD-ROM.

For more detailed information on TCP/IP setup and printing, see Chapter 7, TCP/IP 

Configuration.

Note: Peer-to-Peer uses TCP/IP. Therefore, TCP/IP operation must remain enabled on the 

Network Interface Board, and the Network Interface Board must be assigned a valid 

IP address. By default, the name of the Peer-to-Peer printer as it appears in the Win-

dows Port List is the same as the IP Address assigned to the Network Interface Board. 

You can change the IP address by using a Web browser or MAP. Refer to Chapter 3, 

Monitoring the Network Interface Board, for details.

If you are moving the Network Interface Board from a site that had active TCP/IP to a site 

that does not have it, you should restore the Network Interface Board to the factory default 

settings to clear the IP address and other network information.

5.2.2 Installation and Operation

To install the Windows IP Peer-to-Peer redirector:

1. Put the Network Interface Board CD-ROM into the CD drive on your 

workstation.

2. Choose Start -> Run.
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3. Type the following command and click OK:

drive:\IP-P2P\SETUP.EXE

where drive specifies your CD drive.

4. Follow the instructions in the Setup program.

Note: If the Setup program detected a previous installation of the IP Peer-to-Peer 

Redirector, the program asks whether to delete the old driver and continue the installa-

tion procedure. Click Yes or No.

Once the redirector is installed, each printer on the network that supports this peer-to-peer 

capability appears as a Port under Printer Properties.

5.2.3 Setting Up IP Peer-to-Peer

IP Peer-to-Peer printing allows you to print to a network printer on networks without a file 

server or on a network where you do not want to use the server for printing. You can use 

peer-to-peer printing on Windows 95/98/Me or Windows NT 4.0.

To set up IP Peer-to-Peer printing, choose Start -> IP-P2P -> IP-P2P. The Peer-to-Peer 

printing setup screen appears. The following table describes the fields in the setup screen.

Field or Button Description

Max Hops for 

Search

The hop count determines how many networks the program 

searches to find units. The default count is 2. An entry of 0 

(zero) means the program searches only the network wire 

directly connected to the workstation. An entry of 2 searches 

the wire directly connected to the workstation and also 

searches all networks accessible through two routers. Entries 

of 15 or higher cause an automatic search of every connected 

network. (This is not recommended due to the network traffic 

it could generate.)
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IP Port Base The starting port number for the print server. Each print server 

is assigned an IP port number. By default, the Network 

Interface Board is assigned port number 10001. However, the 

network administrator can change this setting. If the print 

servers on your network have been configured to use a 

different set of port numbers, then you should configure the IP 

Peer-to-Peer software accordingly. Note that IP Peer-to-Peer 

uses the new port number to communicate with all print 

servers.

Note: The IP Port selected here and in the print server should 

be one less than the actual port. For example, if port 10001 is 

desired, the IP Port on the this screen and on the Network 

Interface Board’s HTML pages should be defined as 10000.

Printer Names Lets you select how the printer names are displayed in the 

Windows Port List:

• Based on Serial Number — Uses the print server serial 

number to identify the printer names. For example, if 

SN991354 is the serial number of the unit, SN991354 

would be the printer port.

• Based on IP Address — Uses the IP address to identify the 

printer port. For example, if the IP address for the unit is 

199.99.92.99, the printer port is also 199.99.92.99. (This is 

the default.)

• Based on DNS — Uses the Domain Name Server (DNS) 

name to identify the printer name.

• Based on Unit Name — Uses the Network Interface Board 

Peer-to-Peer name set in the Novell section of the print 

server setup. This is the name used to identify the printer. 

The default name is the Network Interface Board serial 

number (six digits with a three-letter prefix).

Note: If you have both the IP Peer-to-Peer and IPX Peer-to-

Peer Redirector Programs installed, you should not select the 

option to display IP Peer-to-Peer units based on Unit Name. 

This conflicts with the IPX Peer-to-Peer redirector and may 

cause conflicts in the Windows Printer Port List.

Field or Button Description
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When you click Printers, the Windows Port List appears, allowing you to list, search, 

remove and manually add printers.

The following table contains an explanation of the fields and buttons in the Windows Port 

List:

Printers Displays the next program screen.

OK Accepts changes made to setup and exits the program.

Cancel Discards any changes made to setup and exits the program.

Help Displays a description of the Hop Count and IP port number.

Field or Button Description

IP Address Allows you to manually enter the IP address of a printer you 

want to add to the list.

Name The name you want the printer to be listed by in the Unit 

Name field.

Port The actual port for communicating with the printer. Default is 

10001.

Description The description you want listed in the Description field for the 

printer.

Field or Button Description
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Available 

Printers

The list of printers detected on the network. To clear this list, 

click Clear. To update the list, click Find Printers.

• Unit Name — The Printer Name based on the method 

defined in the previous screen. The default Printer Name 

method is by IP address. Printers can also be displayed by 

the Network Interface Board serial number, by the DNS 

Name of the printer, or by the Unit Name. The Unit Name 

is the Print Server Name defined in the Network Interface 

Board.

• Unit IP — The actual IP address of the unit. This appears 

regardless of the selected Unit Name method.

• Port Number — The IP port number used to connect with 

the printer over the network. The default port number is 

10001.

Note: The IP Port selected on the previous screen and in the 

printer should be one less than the number displayed here (that 

is, if port 10001 displays here, the IP Port in the previous 

screen and in the printer should be defined as 10000).

• Description — Typically, the manufacturer's name and the 

printer's model.

• Flags — Selected (S) or Permanent (P)

Any printers flagged with S appear in the Windows Port List. 

When you are adding a or changing a printer, only selected 

printers are listed. Only 30 printers can be selected at one time.

Any printer flagged with P remains in the Available Printers 

list even if the printer is physically removed from the network 

or if you click Clear.

OK Applies the changes you have made to setup and returns to the 

previous screen.

Cancel Discards any changes you have made and returns to the 

previous screen.

Field or Button Description
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5.2.4 Manually Adding Printers for IP Peer-to-Peer Printing

You can add printers manually whenever the program cannot find printers automatically 

because of the router setup or hop count setting. In general, this should not be necessary.

Using IP-P2P to Add Printers to the port list:

1. Choose Start -> IP-P2P -> IP-P2P.

The IP Peer-to-Peer Setup screen appears.

2. Click Printers.

3. Enter information for the printer in all the following fields:

— IP Address

Enter the IP address of the printer you want to add.

Add Lets you manually add a printer to the Available Printers list by 

entering information in the fields to the left of the button. This 

bypasses the Find Printers function. The port is not checked to 

see if it is actually available on the network.

Delete Deletes the highlighted printers from the Available Printers 

list. Printers deleted this way no longer appear in the Windows 

Port List. However, the printer is not actually deleted from the 

network — it is only removed from the list. You can put the 

printer back on the list by clicking Find Printers so long as 

the printer is still connected to the network.

Find Printers Searches the network for printers. The default method for 

displaying the list of printers is by IP Address.

Clear Clears the Available Printers list. This does not clear any 

printer marked with the Permanent flag (P).

Select Flags the highlighted printers with an S. Only 30 printers can 

be selected at one time. When the Windows Port List is 

displayed during the process of adding or changing a printer, 

only selected printers are listed.

Permanent Flags the highlighted printers with a P. These printers remain 

in the Available Printers list even if the printers are physically 

removed from the network or you click Clear.

Field or Button Description
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— Name

Assign a name to identify the printer you want to add.

— Port Number

Enter the port number of the printer. Default is 10001.

— Description

Use this field to describe the printer’s physical location, the users who can ac-

cess the printer, or other convenient description information.

4. When you have entered all the information, click Add.

The printer is listed in the Available Printers field at the bottom of the screen.

5. Highlight the printer you have just added and click the S flag for this printer.

Using the Add Printers Wizard:

1. Choose Start -> Settings -> Printers.

2. Click Add Printer.

The Add Printer wizard appears. Click Next to proceed.

3. Choose the Local Printer option and click Next.

4. Select the make and model of the printer you want to use and click Next.

A list of printer ports appears. Any IP peer-to-peer printers that have been selected 
from IP-P2P Setup appear in this list.

5. Select the IP printer you want to use.

6. Complete the remainder of the printer setup procedure normally.

To change the printer port:

1. Right-click the printer icon.

2. Choose Properties and then choose the Details tab (it can take up to 15 seconds 

to access).

3. Select the printer address you want to use from the Print to the Following Port 

list. (In Windows NT and Windows 2000, you must first deselect the previous 

printer port.)

4. Click OK.
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Chapter 6
AppleTalk Configuration

This chapter describes:

• Creating the printer

• Configuring the Network Interface Board using AppleTalk

• Changing the device names and AppleTalk zones

• Displaying the error log

• Configuring network protocols other than AppleTalk

• Setting up status report printing

6.1 Choosing the Printer

To verify that AppleTalk is enabled:

1. Make sure you have loaded the print driver and file drivers appropriate to your 

printer.

2. Choose Control Panel from the Apple menu.

3. Choose AppleTalk.

4. Choose Connect via Ethernet and close the window.

To create a printer:

1. Choose Chooser from the Apple menu.

A list of AppleTalk zones is displayed (unless your network has only one zone).

2. Select the zone containing the printer from the AppleTalk Zones list, and then 

select the device driver type corresponding to your printer from those in the list in 

the upper left of the screen.

The choice of driver determines the name of the list — Select PostScript Printer, 
Select LaserWriter Printer, and so on.
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3. Select the printer from the Select a Printer list.

The AppleTalk printer name for your printer appears in the Status and 
Configuration report under AppleTalk Connection Information.

4. Click Create.

A dialog box appears so you can choose the PostScript Printer Description (PPD) 
you want.

5. Choose the PPD you want and click Select.

(An additional dialog box may appear depending on the options available for that 
printer.)

The printer now appears both on your desktop and in the list in Chooser.

6. To view printer information, change PPDs, or change other configuration options, 

click Setup.

7. If you are finished, exit from Chooser.
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Chapter 7
TCP/IP Configuration

7.1 Overview

This chapter describes configuring the Network Interface Board and your network for use 

with TCP/IP communication in various environments.This includes:

• Installing in a Windows environment

• Dynamic Host Configuration Protocol (DHCP)

• Windows Internet Name Service (WINS)

• FTP printing

• Printing on UNIX-based systems, including Linux

• Running Telnet

• Using the Internet Printing Protocol (IPP)

The Network Interface Board TCP/IP capability also operates with lpr spoolers on other 

systems, and with spooler/supervisor capabilities that communicate raw print jobs to the 

TCP/IP port.

The IP Peer-to-Peer redirector provided with the Network Interface Board for Windows 

95/98/ME or Windows NT uses this TCP/IP port. The default port number is 10001 but 

can be changed by using Telnet or SNMP or by accessing the Network Interface Board 

HTML pages with MAP or a Web browser. For information on using Telnet, see Section 

7.7 Running Telnet. For information on MAP and the HTML pages, see Chapter 3, 

Monitoring the Network Interface Board.

7.2 Installing in a Windows Environment

Several versions and variations of Windows can be used on NetWare and TCP/IP 

networks, as well as in a native Windows network. This flexibility provides you with 

various options for setting up the network printing system even though this Network 

Interface Board does not support NetBEUI.
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If the Windows workstations are connected to a NetWare network, configure the printer 

interfaces for NetWare and use standard Windows and NetWare utilities to provide access 

to the printer. See Chapter 4, NetWare Configuration.

If you are not using NetWare, you can access the printer using TCP/IP. 

If you are using Windows 95/98 or Windows NT 4.x, you can also use the Network 

Interface Board Peer-to-Peer capability described in Chapter 5, Windows Peer-to-Peer 

Printing.

7.2.1 Installing TCP/IP on Windows

Windows 95/98/ME and Windows NT come with TCP/IP and lpr capabilities, although 

these must be installed when the unit is configured. You must install the TCP/IP Protocol, 

Simple TCP/IP Services, and Microsoft TCP/IP Printing prior to entering the network 

printer on the workstation.

Once lpr is installed on a Windows system and you have allowed printer sharing, other 

workstations can use the printer through the Microsoft Windows Network without having 

to have separate lpr queues installed on each workstation.

7.2.2 Setting Up the Network Interface Board

1. Install the Network Interface Board in your printer.

2. Power up the printer.

Keep the status sheet handy for the Ethernet (MAC) address. It shows that TCP/IP is 

enabled but that the IP address is not configured.

If the unit already has an IP address, these procedures do not work. However, you can use 

Telnet to access the unit and change the IP parameters.

7.2.3 Assigning an IP Address

The Network Interface Board must be given an IP address and routing information to be 

used with TCP/IP. To do this:

• If you have a NetWare connection, use MAP (see Chapter 3, Monitoring the 

Network Interface Board).

• Otherwise, use arp (see Section 7.2.3.1 Using arp) 
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7.2.3.1 Using arp

The Network Interface Board must be on the same network segment as the workstation 

you are using to configure it. The TCP/IP stack must be installed and operating.

To assign an IP Address with arp:

1. Open a DOS command box and enter the following command:

ping psc-ip-address

where psc-ip-address is the IP address you want to use for the Network Interface 
Board. The request should time out with no response (which indicates that the 
address is unused).

2. Enter the following command:

ping ip-address

where ip-address is any valid IP address on your network. The identified unit 
should reply.

3. After the response, enter the following command:

arp -s psc-ip-address mac-address

where psc-ip-address is the IP address of the Network Interface Board and mac-
address is its MAC address.

The entry should be accepted.

4. Enter the ping command from Step 1 again. The request should time out.

5. Let the Network Interface Board reset itself.

The Network Interface Board generates a status page that should include the 
entered IP address.

6. When the Network Interface Board is up again, re-issue the ping command from 

Step 1. Continue until you get a reply.

Note: This only enters the IP address. To enter other IP parameters, use Telnet (Section 7.7 

Running Telnet) or use MAP or a Web browser (see Chapter 3, Monitoring the Net-

work Interface Board).

7.2.4 Setting Other IP parameters

The Network Interface Board provides for a setup connection through the standard Telnet 

port. To make changes to a unit with factory default settings, you must log in as the system 

administrator. You can change this password using Telnet (see Section 7.7 Running 

Telnet).
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To set up IP and lpr parameters:

1. Use Telnet to access the Network Interface Board.

The default login and password are both sysadm.

2. Turn off the protocols you are not using (Option 3).

3. Set up the subnet mask and default gateway for the Network Interface Board, if 

applicable (Option 1).

4. Exit, save, and reset the Network Interface Board.

Alternatively, you can set up IP and lpr parameters by accessing the Network Interface 

Board HTML pages with MAP or a Web browser (see Chapter 3, Monitoring the Network 

Interface Board). The password to change parameters with the HTML pages is the same as 

the Telnet password.

7.2.5 Setting Up lpr on Windows NT or Windows 2000

1. Choose Start -> Settings -> Printers.

2. Click Add Printer.

The Add Printer wizard appears. Click Next to proceed.

3. On Windows NT:

— Choose the My Computer option and click Next.

— Click Add Port. A list of printer ports is displayed.

— Select LPR Port in the list of ports and click New Port. The Add LPR

Compatible Printer window appears.

On Windows 2000:

— Choose the Local Printer option and click Next.

— Choose Create a New Port and select LPR Port from the list.

— Click Next.

4. Specify the IP address of the Network Interface Board. For the name of the printer 

or queue, specify PORT1 (all uppercase, no space) and click OK.

5. On Windows NT: In the list of available ports, put a checkmark next to the LPR 

port you created and click Next.

6. Select the printer manufacturer and printer and click Next.

7. Optionally, specify the printer name and click Next.

8. You can choose the Shared option and select one or more operating systems that 

will print to this printer. Click Next.
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9. Print a test page and click Finish.

7.3 Dynamic Host Configuration Protocol (DHCP)

DHCP is a service that provides a method for assigning and maintaining IP addresses. The 

Network Interface Board obtains IP information from this service.

There are two user-defined variables related to the DHCP function:

• DHCP enable

• Use IP info in NVRAM

These variables are accessible in the TCP section of Network Administration, in the 

HTML pages.

If DHCP is not enabled:

• The Network Interface Board makes no DHCP requests under any circumstances.

If DHCP is enabled:

• The Network Interface Board makes DHCP requests when the Network Interface 

Board is reset or on power up, provided that the Network Interface Board does not 

have an IP address stored or that “Use IP info in NVRAM” is OFF. 

• If the Network Interface Board has an IP address in NVRAM and “Use IP 

info in NVRAM” is ON, the Network Interface Board uses the IP information 

from NVRAM and there is no DHCP activity on the part of the Network Interface 

Board.

The factory default is DHCP disabled and “Use IP info in NVRAM” is set ON. 

When DHCP is enabled and IP address in NVRAM is set OFF, the Network Interface 

Board issues DHCP requests if it does not already have IP identification information 

stored in NVRAM.

7.4 Windows Internet Name Service (WINS/DHCP)

Windows Internet Name Service (WINS) allows a device, such as your print server, to 

register a NetBIOS name such as the Network Interface Board serial number (six digits 

with a three-letter prefix) along with its current IP address (for example, 199.92.187.171). 

A client that wants to contact the printer uses the WINS server to match the NetBIOS 

name with an IP address. Most users find it easier to remember the NetBIOS name for the 

printer rather than its IP address.
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7.4.1 Using WINS with Your Print Server

To use WINS with your Print Server, enter the IP address of the WINS Server on the 

TCP/IP configuration screen. You can access this screen with a Web browser or MAP 

utility (refer to Chapter 3, Monitoring the Network Interface Board).

7.4.2 Configuring the WINS Server

You can configure your DHCP Server to automatically provide WINS Server information 

to the print server, or you can use the print server’s TCP/IP Configuration Menu to 

manually enter the necessary information. Refer to your DHCP Server’s documentation 

for further information on automatic configuration through the DHCP Server.

To manually configure your print server to work with the WINS server:

1. Assign an IP address to the print server.

To assign the address, you can use MAP, Address Resolution Protocol (arp), 
DHCP, Reverse Address Resolution Protocol (rarp).

2. Run your Web browser — Internet Explorer or Netscape Navigator.
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3. Choose File -> Open.

The Open dialog box opens.

4. Enter the print server’s IP address to access the print server’s TCP/IP 

Configuration Menu.

5. Choose TCP/IP Configuration from the main menu.

The NetBIOS Name for the print server is shown on this screen. The default name 
is the Network Interface Board serial number (six digits with a three-letter prefix) 
unless you have previously configured a name for the print server with DHCP.

6. Optionally, specify a new NetBIOS name (15 characters or less).

7. If you have previously configured a DHCP Server to provide the print server with 

the IP address of the Primary WINS Server, the address is shown on the TCP/IP 

Configuration Menu. Otherwise, specify the IP address of the Primary NetBIOS 

Name Server here.

8. Optionally specify the IP address of a Secondary NetBIOS Name Server as well. 

If you have configured your DHCP Server to provide the address of a Secondary 

WINS Server to the print server, the address fields are automatically completed 

for you.

9. Reboot the printer/print server.

The printer’s status page now shows that the print server has successfully 
registered with the WINS server. The check boxes labeled “Primary Server 
Logged in” and “Secondary Server Logged in” on the TCP/IP 
Configuration Menu now indicate any WINS Servers with which the print server 
has registered.

Normally, the print server automatically renews its registration with the WINS 
Server before its lease expires.

7.5 FTP Printing

7.5.1 FTP Printing Using Netscape

FTP printing with Netscape requires Navigator 2.0 or higher.

To print from Netscape:

1. Connect to the port you want to send the print job to on your print server.
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2. Enter the command:

ftp://PORT1@dest-srvr-addr

where dest-srvr-addr is the IP address of the print server to which you want to 
send the print job.

3. Run Netscape.

4. Choose File -> Upload File and specify the file, or drag and drop the file to your 

browser window and click OK.

Note: FTP printing does not support selecting multiple file names. Only one user can be 

logged on to a port at any particular time.

7.5.2 Printing from an FTP Client

1. Open a DOS Command window and enter the following command:

ftp dest-srvr-addr

where dest-srvr-addr is the IP address of the print server to which you want to 
send the print job.

2. Specify PORT1 as the login.

3. Enter the following FTP command:

put filename

where filename is the file you want to print.

7.6 UNIX Printing

The Network Interface Board can support UNIX TCP/IP printing in the following mode:

• Printer-based lpd where the printer appears as a host running a line printer 

daemon

In general, printer-based lpd is easiest to use on BSD UNIX systems, requiring an entry 

in the printcap file once the Network Interface Board has its IP information. 

7.6.1 Configuring the IP Address on the Network Interface 
Board

The Network Interface Board must be given IP address and routing parameters. You can 

configure the IP address for the Network Interface Board in one of the following ways:

• Use MAP, as described in Chapter 3
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• Use the reverse ARP (rarp, Ethernet II frame type only).

• Use arp and ping

For each method, you need to provide the Ethernet address of the Network Interface 

Board. The Ethernet address is the 12-character code that is printed under Network 

Address on the configuration status report each time the printer is turned on.

You can use the rarp, or ping procedures only when the Print Server is in its factory 

default state (no IP information entered.) After the Print Server has an IP address, you 

must use the Telnet utility or the Network Interface Board HTML management pages 

accessed through the MAP utility or a web Browser to change an IP address, Subnet Mask 

and Default Gateway.

7.6.1.1 Using rarp

The Reverse Address Resolution Protocol (rarp) allows network devices to query a 

server for their IP addresses on start up. For this procedure, there needs to be a workstation 

with a rarp server. To store the IP address, use the following procedure:

1. Turn off the printer.

2. Log in as superuser on a host on the same subnet as the print server.

However, if the server resides on another subnet, complete this procedure to store 
the IP address in the print server. Reconnect the print server anywhere on the 
network, and then use the TelNet or the HTML pages accessed by MAP or a Web 
Browser to adjust the IP parameters for the subnet on which the Network Interface 
Board is operate.

3. Find the Ethernet address of the Network Interface Board. The address is printed 

on the configuration status report when you power on the printer.

4. Edit the hosts file (usually /etc/hosts) or use NIS or DNS to add the IP 

Address and Network Interface Board’s node name. See the network 

administrator for the IP address.

For example, a print server with the name of printfast has the following entry:

192.9.200.200 printfast

5. Edit the /etc/ethers file or use NIS or DNS to add the Ethernet address.

To continue the example, for the printfast card with an Ethernet address of 
00:40:c8:00:00:ff, make the following entry:

0:40:c8:0:0:ff printfast

6. If the rarp daemon is running, stop it and restart it. Verify that the daemon is 

running.

7. Check the printer to see that the print server is connected to the network. Turn on 
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the printer.

8. Wait until the printer powers up and finishes initializing to allow enough time for 

the IP address to become known and to be saved in non-volatile memory. The 

Network Interface Board should then reset itself.

9. After the Network Interface Board has reset, use the ping command to verify that 

the print server obtained its IP address. For example:

ping 192.9.200.200

If the server has the address, the result is a confirmation message:

192.9.200.200 is alive

10. Remove, or comment out, your changes to the /etc/ethers file.

11. Stop the rarp daemon and, if you want it to run, restart it.

7.6.1.2 Using ping

Use the following procedure to enter the IP Address:

1. Turn off the printer.

2. Log in as superuser on a host on the same subnet as the print server.

However, if the server resides on another subnet, complete this procedure to store 
the IP address in the print server. Reconnect the print server anywhere on the 
network, and then use Telnet or the HTML pages accessed by MAP or a Web 
Browser utility to change the IP Address.

See 7.7 Running Telnet, for instructions on using Telnet.

3. Find the Ethernet address of the Network Interface Board. The address is printed 

on the configuration status report each time you turn the printer on.

The address is printed on the configuration status report each time you turn the 
printer on.

4. Edit the hosts file (usually /etc/hosts) or use NIS or DNS to add the IP address 

and print server's node name. See the network administrator for the IP address.

For example, a print server with the name of printfast has the following entry:

192.9.200.200 printfast

5. Add an entry to the arp cache for the Print Server’s IP address and Ethernet 

address.

For example:

arp -s 192.9.200.200 0:40:c8:0:0:ff

6. Check the printer to see that the Print Server is connected to the network. Turn on 

the printer.
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7. Send a ping command the Network Interface Board to verify it is running on the 

network.

For example:

ping 192.9.200.200 or

ping printfast

The Network Interface Board will not respond to this ping command but it will 
read its IP address from the packets.

8. Turn the printer off and back on again and then send the ping command again to 

verify that the print server obtained its IP address. If the Print Server has the 

address, the result is a confirmation message:

192.9.200.200 is alive

9. Remove the entry from the arp cache using the following command. Specify the 

Print Server either by its IP address or by its name.

For example:

arp -d printfast

7.6.2 lpd/lpr Printing

The lpd/lpr is an implementation of the standard UNIX line printer daemon which lets 

you print across a TCP/IP network without installing software on your workstation with 

all filtering and banners done by the Network Interface Board. Remote printing uses the 

same commands (lpr, lpq, lpc) as local printing.

The process begins when the lpr call finds a printer on a remote system by looking at the 

remote (rm) entry in the /etc/printcap file for that printer. The lpr handles a print job 

for a remote printer by opening a connection with the lpd/lpr process on the remote 

system and sending the data file (followed by the control file containing control 

information for this job) to the remote system. The printer-based lpd then filters the data 

and prints the job according to information contained in the control file and its own 

printcap file.

The Network Interface Board lpd recognizes the format of certain printer emulations and 

filters the data, if possible, so the data can be printed on the printer type you specify.

You can indicate to the Network Interface Board lpd what type of printer is attached to by 

either:

• Accept the default port setting (PCL, PostScript, and other)

• Change the listed emulations via the Telnet or the HTML pages accessed by MAP 

or a Web Browser utility

The following sections give specific lpd/lpr setup instructions for various systems.
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7.6.2.1 Setting Up a BSD Remote Printer to Use lpd

To set up a remote printer on the host that sends jobs to Network Interface Board using 

printer-resident lpd, add an entry to the /etc/printcap file on your host for each 

printer you use.

The steps are described below.

1. Open the /etc/printcap file. Make an entry naming the Network Interface 

Board as the remote host and PORT1 as the remote printer name. A typical 

printcap entry is shown below:

<printer_name>\

(for example, lprprinter)

:lp=:\

:rm=<remote_host>:\

(for example, name as entered in /etc/hosts)

:rp=PORT1:\

:sd=/usr/spool/lpd/<printer_name>:

(for example, spool directory on system used to 

spool data and control files)

This entry will send jobs spooled at /usr/spool/lpd/<printer_name> to the 
printer designated <printer_name> to be printed at lp(the internal connection to 
the printer) of the Network Interface Board designated as <remote_host>.

2. Create the spooling directory. For example, type:

mkdir /usr/spool/lpd/<printer_name>

3. To print via the spooler, use the lpr command. Type:

lpr -P<printer_name> <file_name>

Installation and testing is done. You are now ready to print.

7.7 Running Telnet

The Telnet utility uses the standard remote terminal protocol to configure the IP address, 

lpd/lpr printers, and other parameters on your system. You have the same functionality 

with Telnet as with accessing the Network Interface Board HTML pages with MAP or a 

Web browser (see Chapter 3, Monitoring the Network Interface Board).

Use the following guidelines to run Telnet:

• Typically you make selections from menus by toggling between one choice or 

another, by selecting/deselecting or enabling/disabling an item.

• Press Enter when not selecting an item. This returns you to a previous menu.
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• If you do not make a menu selection for two minutes, you get a two-minute 

warning that within two more minutes your Telnet session ends. This ensures that 

no one user leaves a session idle for too long.

7.7.1 Making the Connection and Accessing the Main Menu

To make the connection and access the Main menu:

1. At the prompt, type the following command:

telnet ip-address

where ip-address is the IP address of the card.

2. When the login prompt appears, type guest if you are interested in only browsing 

the menus, or type sysadm if you want to change the configuration.

3. When the password prompt appears, again type guest or sysadm.

The main menu is displayed. This utility lets you change the IP parameters, 
lpd/lpr printers, protocols, and password, and lets you restore to factory 
defaults.

4. Type the number for the parameter you want to check or change and press Enter.

5. To end your Telnet session, type E at the Main Menu.

If you have made any changes you are prompted to either Save Changes and Exit 
or Exit Without Saving Changes. Choose the appropriate option and press Enter.

Note: To get online help in Telnet, type ? (question mark).

1. IP Parameters

2. LPD Printers

3. Protocols

4. Restore Factory Defaults

5. Change Password

E. Exit
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7.7.2 Configuring IP Parameters

Although the Network Interface Board must have an IP address before a Telnet connection 

can be made, you can use the Telnet utility to change the address or the other IP 

parameters. The Network Interface Board automatically initiates a soft reset when it 

senses the IP address change.

Note: This causes the Telnet connection to be broken. It is advisable to make all other 

desired changes before changing the IP address.

To configure IP parameters:

1. At the main menu, type 1 and press Enter to display the IP Parameters menu.

2. Type 1 again and press Enter.

The IP Address submenu is displayed:

3. Type the number for the parameter you want to change and press Enter.

Note: The base port number is one less than the actual TCP/IP port number used by the 

printer. For example, to set the port number to 9100, enter 9099.

7.7.3 Selecting Printer Languages

Selection 2 in the main menu lets you designate the emulations (printer interpreter 

languages) that the printer supports. This lets the resident lpd/lpr modify files intended 

for other emulations so they can be printed. The menu also allows you to enable or disable 

banners attached to lpd/lpr handled jobs.

The emulation choices are:

• Printer Control Language (PCL)

• PostScript (PS)

• ASCII (simple text)

• Other (any print job not recognized as PCL, PS, or ASCII)

1. IP Address              199.92.187.37

2. Subnet Mask           255.255.255.0

3. Default Gateway     199.92.187.254

4. Base Port Number   10000
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The file modifications and conditions are:

To select the printer language:

1. To access the LPD Printers menu, type 2 and press Enter.

For a unit at factory default, the following menu appears.

2. To change the set of emulations, type 1 and press Enter.

The following options are displayed.

3. To delete an emulation, select the number opposite the language listed and press 

Enter.

4. From the LPD Printers menu, type 2 to toggle Banners between Enabled/

Disabled.

Print Server Setup Job detected as Action

PCL, (PostScript) ASCII <CR> changed to <CR><LF>

PostScript PCL, Other PostScript header added

not PostScript PostScript Job discarded

PostScript ASCII PostScript  header added, <CR> 

changed to <CR><LF>

PCL, PS, ASCII any No action

LPD Printers

1. Printer 1            PCL PS OTHER

2. Banners             DISABLED

Printer 1                  PCL PS OTHER

1. PCL

2. PS

3. ASCII

4. OTHER
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7.7.4 Enabling/Disabling Network Protocols

To enable network protocols, type 3 at the main menu.

You are given the choice of disabling either NetWare or AppleTalk since both network 

OSs are enabled by default. For example, to disable Appletalk, type 2 and press Enter.

7.7.5 Restoring Factory Defaults

When you need to restore factory defaults on your print server, type 4 at the Main Menu 

and press Enter. All NVRAM stored parameters are returned to their factory default 

values. The factory default values do not take effect until you exit the Telnet program or 

the unit is powered off and on.

7.7.6 Changing a Password

1. Type 5 at the main menu.

2. Type up to eight characters at the New Password query and press Enter.

3. Retype the same characters at the Retype New Password query and press Enter.

4. Choose the Save Changes and Exit option.

Once you have set your password, the sysadm password is no longer valid.

Note: There is a single maintenance access password to the Network Interface Board. You 

use this password with Telnet or when accessing the Network Interface Board HTML 

pages with MAP or a Web browser.

7.7.7 Exiting Telnet

1. Type E at the main menu.

If you have made any changes, the exit menu is displayed:

Exit

1. Save Changes and Exit

2. Save Changes and Reset

3. Exit Without Saving Changes
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2. Choose an exiting option and press Enter.

7.8 Internet Printing Protocol (IPP) Printing

7.8.1 Setting Up a Printer Using IPP

You can use the IPP with Windows 2000.

To set up a printer for IPP printing:

1. Assign an IP address to your print server.

2. Reset the print server.

3. Use the ping command to make sure the print server responds.

7.8.2 Setting Up the IPP Functions of the Printer 

You can set up the IPP functions of the printer by using MAP or a Web browser. For IPP 

printing, your workstation must have an IPP client installed (either from Microsoft or a 

third-party).

To configure the printer for printing:

1. Choose Start -> Settings -> Printers.

2. Click Add Printer.

The Add Printer wizard appears. Click Next to proceed.

3. Choose the Network Printer option and click Next.

4. On the Locate Your Printer screen, select Connect to a printer on the Internet 

or on your intranet and type the correct printer path. (case sensitive)

The format is:

URL: http://ip-addr:631/Print

where ip-addr is the IP address of the printer. For example:

URL: http://199.92.186.97:631/Print

Note: Your printer port number is listed on the NIB Status Page next to the Internet Printing 

Protocol.

5. Click Next and finish printer setup.

For example, select the appropriate printer type.

6. Perform a Test Print from your printer and check the printer for the test page.
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The printer configuration is complete.
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Chapter 8
Operation and Troubleshooting

This chapter describes:

• Normal operation of the Network Interface Board in the printer

• LED status indicator

• Status reports

• Resetting the Print Server to factory defaults

• Troubleshooting any problems you might have with the Network Interface Board

8.1 LED Status Indicators

The Network Interface Board has two LED status indicators: orange and green. The 

orange LED generally indicates job activity. The green LED indicates the operating 

condition of the Network Interface Board.

8.1.1 Normal Operating Condition

Green LED

• When you first power on the printer, the green LED is on solid (that is, not 

blinking). This indicates that the Network Interface Board is performing self tests. 

The green LED may also be on solid when the printer is awaiting a print job and 

the Network Interface Board is functioning properly.

• When the printer finishes the self-tests, the green LED blinks, and may blink 

again after initialization with the printer is completed. If the Print Status Report on 

Power up feature is enabled, the Network Interface Board generates a status 

report.

Orange LED

• When the printer is receiving print jobs over the network, the orange LED blinks. 

It is off when there is no activity.

• The orange LED is on solid (not blinking) to indicate that the network connection 

has been lost — typically, because the server has been shut down.
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8.1.2 Error Conditions

Combinations of blinking LEDs — 1 to 7 orange blinks followed by 1 to 12 green blinks 

— indicate various hardware failures. You should then notify the supplier of your printer 

according to whatever arrangements you have for technical support or replacement of 

defective equipment.

8.2 Status Report

The Status/Configuration report is generated when the print server is powered on (if the 

Print Status Report on Power up feature is enabled). The following sample report shows 

the configuration of the print server immediately before the report is printed. Some 

printers also allow you to use a command from the front panel that produces a status 

report.

You should generate and review a status report after installation and any time the setup 

changes. If your status report does not include a protocol that was configured, make sure 

the procedure was done properly.

Sample Status Report
---------------------------------------------------------------------

Unit Serial No: 123456               Version: 05.60

Network Address:  00:11:22:33:44:55

Network Topology: Ethernet           Connector: RJ45

Network Speed: 100 Megabits

Novell Network Information           enabled

    Novell Print Server Name: RDP_123456

    Password Defined: No

    Directory Services Context not defined

    Frame Type: 802.3

Peer-to-Peer Information             enabled

    Frame Type: 802.2 on 802.

    Network ID: 6

TCP/IP Network Information           enabled

    Frame Type: Ethernet II          Protocol Address: 123.123.123.123

    Subnet Mask: 123.123.123.123     Default Gateway:  123.123.123.123

    WINS Name:

IPP Network Information              enabled

    Internet Printing Protocol       http://123.123.123.123:631/Print

AppleTalk Network Information        enabled
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    Frame Type: 802.2 SNAP on 802.3

    Protocol Address: Net Number 123 Node Number:45 Socket Number 678

    Preferred AppleTalk Zone:        Default Zone

Novell Connection Information

    Printer Name: Assigned Name

    File Server: NameOfFileServer

        Queue:  NameOfQueue  Priority: 1     Attached: yes

        Notify: Supervisor   First:    30    Repeat:   60

Peer-to-Peer Connection Information

    Port Name: RDP_123456

AppleTalk Connection Information

    AppleTalk Printer Name: RDP_123456

TCP/IP Connection Information

    Port Number: 10001

---------------------------------------------------------------------

8.3 Returning the Network Interface Board to Factory Default Set-
tings

You can restore parameters on the Network Interface Board to their factory default 

settings. You should do this before the Network Interface Board is moved to a new 

location where the environment (AppleTalk network zones, NetWare file servers, IP 

subnets, and so on) is different.

Note: Returning to factory default settings means that the print server loses all data such as 

names and IP addresses. It does not lose its serial number or MAC (Ethernet or Token 

Ring hardware) address.

To restore the factory default settings, you can use Telnet or the Network Interface Board’s 

HMTL pages (via MAP or a Web browser). If the network is not available, you can use the 

following method.

To reset the Network Interface Board:

1. Power off the printer and remove the Network Interface Board from the printer.

The removal process is the reverse of the installation process described in Chapter 
2, Installing the Network Interface Board.

2. Locate the Reset Jumper (labeled OP2. Refer to the diagram in Appendix A). 

Move this jumper to the ON position.
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3. Reinstall the Network Interface Board as described in Chapter 2 but do not 

connect the printer to the network.

4. Power on the printer.

The Network Interface Board performs self-diagnostic tests. The green LED 
blinks 3 times and then goes into an alternating green/orange sequence. When you 
see this LED pattern, do the following steps.

5. Power off the printer.

6. Remove the Network Interface Board from the printer.

7. Move the OP2 jumper to its OFF position, so that the jumper covers the center pin 

and the pin nearest the OFF designation.

8. Reinstall the Network Interface Board according to Chapter 2, Installing the 

Network Interface Board.

9. Reconnect to the network and power on the printer.

8.4 Troubleshooting Checklists

8.4.1 General Troubleshooting

Use the following list to determine the cause of printing problems:

• Verify that the printer is functioning properly:

— Is the printer printing? To check whether the printer is operating properly, 

make it generate a test page. See your printer’s owner’s manual for instructions 

on generating a test page.

— Is the printer on-line?

— Does the control panel indicate an error? Refer to your printer documentation 

for an explanation of the error messages.

— Did you get a Network Interface Board status page (if the Print Status Report 

on Power up feature is enabled)? On preppy, the Network Interface Board 

sends a status page which contains information that is useful for troubleshoot-

ing. Keep the status page available until the problem is resolved.

— Check the Network Interface Board’s LED status indicators to make sure there 

is no error condition. See Section 8.1 LED Status Indicators for more informa-

tion.

— Check the status report to see what protocols are enabled and active.
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• See the appropriate chapter of this manual to confirm that you have installed and 

configured your network protocol correctly for the Network Interface Board. See 

Section 8.2 Status Report for a sample status report.

• If you added, changed, or removed any hardware on the network, verify that it 

was installed or removed correctly.

• If you added any new software applications, make sure the program is compatible 

and installed correctly on the network. See your network protocol documentation 

for more information.

• Can other users print? If they cannot print and they are all using the same network 

protocol, go to the troubleshooting section for that protocol.

When you have determined the nature of the problem, use the checklists in the next 

section.

8.4.2 Troubleshooting Network Hardware Connections

• Make sure the Network Interface Board has properly selected the connector type 

that you are using. The connector type is on the status/configuration report — 

RJ45 or BNC.

• For Thinnet, check that the network connector is plugged into the BNC connector 

on the Network Interface Board. If the printer is at the end of a run, ensure that a 

50-ohm terminator is installed.

• For 100BaseT or 10BaseT, check that the network connector is plugged into the 

RJ45 connector on the Network Interface Board.

• If the network connectors are properly plugged in and the problem persists, try 

another cable.

• If you are using a 10BaseT Network Interface Board connected to a concentrator 

hub that does not support the link signal, use Manual Ethernet Port selection 

instead of the factory default of Automatic Ethernet Port selection. See Appendix 

A, Jumper Settings.

8.4.3 NetWare Troubleshooting

Use MAP to get the NetWare setup and parameter values. If you cannot resolve the 

problem after running MAP, go through the checklists in this section.
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8.4.3.1 NetWare Checklist

• Is the print server name entered correctly?

• The default name is the Network Interface Board serial number (six digits with a 

three-letter prefix). This number is located on the card.

• Did you assign print queues to the printer?

• It is recommended you assign each print queue to only one Network Interface 

Board-connected printer. If print queues are assigned to other network printers, 

the print jobs might be going to another network printer.

• Did you assign the printer to the type Remote Other/Unknown?

• If the server settings are correct, the connection between the printer and network 

might have been broken. In this case:

— Turn the printer off and, using NWADMIN or PCONSOLE, wait for the status 

message Not Connected.

— Turn the printer on and the status should change to Waiting for Job.

8.4.3.2 File Server Checklist

• Is there enough disk space on the file server and is it running?

• Is  the correct file server associated with the printer? Use NWADMIN or 

PCONSOLE to check this.

• Did you have the proper rights to configure the printer?

• Are the File Server and the Print Server communicating? Run the NetWare 

COMCHECK utility from any network workstation to check this.

• Are there enough user positions on the File Server? The Print Server function logs 

on as a user.

8.4.3.3 Workstation Checklist

• Is the network loaded onto the workstation?  See your Novell documentation.

• Is the application set up to print to the printer?  For example, are you using the 

correct driver?

• Is the workstation connected to the correct print queue?  Print a file and verify that 

the file goes to the queue.

• Are the print queues assigned to the Network Interface Board-connected printer 

also assigned to another network printer? If so, the print jobs may be going to that 

printer.
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• From NWADMIN or PCONSOLE, enter a sample print job directly into an 

assigned queue. Does the job become Active? Is the job printed?

• Is AUTO ENDCAP enabled? This option lets you send data to a network printer. 

Use PRINTCON to check.

8.4.3.4 Network Interface Board Configuration Checklist

If all your hardware connections are correct, check the following:

• Use MAP to check the status of the print server. 

The Report Print Server Status screen shows the status for the selected Network 
Interface Board. This report includes a status of file servers and queues assigned 
to a printer along with a description of any problems.

• The printer might not be assigned to the correct print queues. 

Use NWADMIN or PCONSOLE to direct print jobs to the correct queues, then 
check to see if the print job is in the queue.

• If devices were added or changed, use NWADMIN or PCONSOLE to make sure 

you configured the new devices correctly.

• Make sure the Network Interface Board’s name has been entered correctly. If you 

changed the name in MAP, you must also change the name in NWADMIN or 

PCONSOLE before you can print.

• Use NWADMIN or PCONSOLE to check the printer status. Make sure it is not 

stopped or paused.

8.4.3.5 Printer Server, File Server, and Printer Checklist

• Can the Network Interface Board log in to the file server, and can it service jobs 

from a file server?

• Is the print server name listed on that file server?

• Does the print server password assigned to the Network Interface Board through 

NWADMIN or PCONSOLE match the print server password assigned through 

MAP?

(Use MAP to update the password stored in the network print server’s memory.)

• Is the print job in the print queue and waiting to be printed? Use NWADMIN or 

PCONSOLE to check whether the print jobs are being sent to the printer.
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8.4.3.6 Workstation to Network Interface Board Connection Checklist

To make sure the workstation is communicating with the Network Interface Board:

• Print a file from the workstation. Use NWADMIN or PCONSOLE to verify that 

the print job gets to the print queue. If the print job does get to the queue, the 

problem is not with the workstation/print server connection.

• Use CAPTURE to send data to the printer from a software application. See your 

Novell documentation for information.

• Make sure another printer is not taking the print jobs from the queues before the 

Network Interface Board can service the job. Disable the other printer until you 

can verify the Network Interface Board-connected printer setup.

8.4.3.7 If the Network Interface Board Loses Its File Server Connection

If the network interface board loses its connection to the file server, it can take 

approximately 5–10 minutes to reconnect.  If the connection is not made after some 

reasonable time, check the error conditions to troubleshoot the problem.

8.4.3.8 Cannot Print from a Different Context

The Network Interface Board does not support printing from a context different from the 

context you are installed in. If you want to do this, you must create an alias queue. See 

your Novell documentation for more information.

8.4.4 AppleTalk Troubleshooting

• Is the Macintosh connected to the network through Ethernet and has the 

AppleTalk driver been selected? To check, choose Control Panel from the Apple 

menu and then choose Networks.

• Did you select the correct Network Interface Board and correct zone?

• Is AppleTalk enabled on the Macintosh? Use Chooser to check this.

• If you are on a network with multiple zones, is the zone correct?

• Did you select the correct printer driver in Chooser? You must first select the 

printer icon and then select the printer name. (Not all printers communicate with 

the default Macintosh driver.)

• If you renamed the printer in the AppleTalk program, did you re-select the printer 

under its new name?

• If you put the printer in a new zone, did you re-select the zone?

• Are there other printers with similar names in Chooser? Make sure you chose the 

Network Interface Board-connected printer.
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8.4.5 TCP/IP Troubleshooting

Problem: Cannot access the Network Interface Board from the network

• Make sure the Network Interface Board has a valid IP address. Use ping to check 

the IP address assigned to the card.

• Check the TCP/IP parameters (subnet mask, gateway, and so on).

• If your network supports DHCP or WINS:

— Are the server names set correctly on the Network Interface Board Status Con-

figuration page?

— Is the DHCP Server or WINS Server running?

— If the DHCP Server or WINS Server is running, is it configured properly? Re-

fer to your network documentation for more information on configuring serv-

ers.

Problem: Cannot print from lpr

• Do you have the correct drivers?

• Is the print job directed to the correct IP address?

• Is the lpr channel full because of other jobs in the queue?

Problem: Cannot print from IP-P2P or Windows 2000 direct IP

• Do you have the correct drivers?

• Is the print job directed to the correct IP address?

• Is the correct port number being used for Raw Sockets printing? (The default for 

the Network Interface Board is 10001.)

• Is the printer reporting any errors?

• Was the print job removed from the spooler? (Check the Windows spooler for any 

details on the status of a failed job.)

Problem: Cannot print from IPP

• Do you have the correct drivers?

• Is the print job directed to the correct IP address in the IPP client (that is, 

http://ip-address:631/Print)?

• Was the print job removed from the spooler? (Check the Windows spooler for any 

details on the status of a failed job.)
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Appendix A
Jumper Settings

This appendix describes:

• Changing jumper settings

• Network Interface Board and jumper locations 

• Reset to factory defaults

• BUS handshake

• Ethernet-specific jumpers (10BaseT only)

A.1 Changing Jumper Settings

The Network Interface Board normally configures the network configuration 

automatically without the need to access internal jumpers. However, there are certain 

jumpers on the board that you might have to access under certain circumstances. If you 

need to change the jumpers, follow the steps in this section.

Note: Handling Precautions for Static Sensitive Devices: The Network Interface Board is 

designed to protect sensitive components from damage due to electrostatic discharge dur-

ing normal operation. When installing the card, however, take proper static-control pre-

cautions to prevent damage to equipment.

Make sure you do not have the printer plugged into a wall outlet. If it is plugged in, unplug 

the power cord before you open the unit. Remove the Network Interface Board according 

to the printer instructions.

A.2 Reset to Factory Defaults

The Network Interface Board can be restored to factory default conditions by jumper OP2. 

The function of OP2 is to reconfigure NVRAM. Do this when a unit is moved from one 

site to another and should be restored to as-new condition.

If the unit is powered up with jumper OP2 in the FACT position (opposite of the CUST 

position), the board resets all parameters to their factory default values. This is indicated 
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by the three quick green flashes followed by the alternating amber and green indications 

(once per second rate). You should then turn off power and shift the OP2 jumper to the 

CUST or OFF position (opposite of the FACT or ON position). The unit operates normally 

when you turn the power on again.
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Appendix B
Network Interface Board Specifications

This appendix describes:

• General specifications for the Network Interface Board

• 10/100BaseT cables

B.1 General Specifications for the Network Interface Board

Size: Length: 123.7 mm Width: 95 mm

Weight: 8 ounces

Environment: 0–50° C 5%–80% humidity

Controls and Indicators: One green LED and one amber LED

Configuration: Stored in NVRAM

Connectors: Any of the following:

• Ethernet: 8-wire RJ45 10/100BaseT
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B.2 10/100BaseT Cables

Use the following universal Ethernet standard when configuring your 

10/100BaseT cables to connect to the RJ45 connector on the Network Interface Board. 

The cable should be Category/Type 5 or better (depending on length).

Pin Color Ethernet

8 Blue/white

7 Blue

6 Orange/white Receive –

5 Green/white

4 Green

3 Orange Receive +

2 Brown/white Transmit –

1 Brown Transmit +
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